Thank you for purchasing these FUJIFILM products. This "Software Quick Start Guide" describes how to connect the camera to the USB port on your PC and how to install the enclosed software on your PC. It also provides a quick guide to using the software and a section on troubleshooting any problems that may arise. Read this manual carefully to ensure that you make the best possible use of the software. For detailed information on using FinePixViewer and DP Editor, refer to the User's Guide (PDF).
BEFORE OPENING THE PACKAGE OF CD-ROM PROVIDED BY FUJI PHOTO FILM CO., LTD., PLEASE READ THIS END USER LICENSE AGREEMENT CAREFULLY. ONLY IF YOU DO AGREE TO THIS AGREEMENT, YOU WILL BE ABLE TO USE THE SOFTWARE RECORDED ON THE CD-ROM. BY OPENING THE PACKAGE, YOU ACCEPT AND AGREE TO BE BOUND BY THIS AGREEMENT.

End User License Agreement

This End User License Agreement ("Agreement") is an agreement between Fuji Photo Film Co., Ltd. ("Fuji") and you, which sets forth the terms and conditions of the license granted for you to use the software provided by Fuji. The CD-ROM contains third party software. In case a separate agreement is provided by a third party supplier for its software, the provisions of such separate agreement shall apply to the use of such third party software, prevailing over those of this Agreement.

1. Definitions.
   (a) “Media” means the CD-ROM titled “Software for FinePix EX” which is provided to you together with this Agreement.
   (b) “Software” means the software which is recorded on Media.
   (c) “Documentation” means the operation manuals of Software and other related written materials which are provided to you together with Media.
   (d) “Product” means Media (including Software) and Documentation collectively.

2. Use of Software.
   Fuji grants to you a nontransferable, nonexclusive license:
   (a) to install one copy of Software onto one computer in binary machine executable form;
   (b) to use Software on the computer onto which Software is installed; and
   (c) to make one backup copy of Software.

   3.1 You shall not distribute, rent, lease or otherwise transfer all or any part of Software, Media or Documentation to any third party without Fuji’s prior written consent. You also shall not sublicense, assign or otherwise transfer all or any part of the rights granted to you by Fuji under this Agreement without Fuji’s prior written consent.
   3.2 Except as expressly granted by Fuji hereunder, you shall not copy or reproduce all or any part of Software or Documentation.
   3.3 You shall not modify, adapt or translate Software or Documentation. You also shall not alter or remove copyright and other proprietary notices that appear on or in Software or Documentation.
   3.4 You shall not, or shall not have any third party, reverse-engineer, decompile or disassemble Software.

4. Ownership.
   All copyrights and other proprietary rights to Software and Documentation are owned and retained by Fuji or the third party suppliers as indicated on or in Software or Documentation. Nothing contained herein shall be construed, expressly or implicitly, as transferring or granting any right, license, or title to you other than those explicitly granted under this Agreement.

5. Limited Warranty.
   Fuji warrants to you that Media is free from any defect in material and workmanship under normal use for ninety (90) days from the date of your receipt of Media. Should Media not meet the foregoing warranty, Fuji shall replace such defective Media with other Media bearing no defect. Fuji’s entire liability and your sole and exclusive remedy with regard to any defect in Media shall be expressly limited to such Fuji’s replacement of Media as provided herein.

6. DISCLAIMER OF WARRANTY.
   EXCEPT AS PROVIDED IN SECTION 5 HEREIN, FUJI PROVIDES PRODUCT “AS IS” AND WITHOUT WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED. FUJI SHALL MAKE NO WARRANTY, EXPRESS, IMPLIED OR STATUTORY, AS TO ANY OTHER MATTERS, INCLUDING, BUT NOT LIMITED TO NON-INFRINGEMENT OF ANY COPYRIGHT, PATENT, TRADE SECRET, OR ANY OTHER PROPRIETARY RIGHTS OF ANY THIRD PARTY, MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE.

7. LIMITATION OF LIABILITY.
   IN NO EVENT SHALL FUJI HAVE ANY LIABILITY FOR ANY GENERAL, SPECIAL, DIRECT, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR OTHER DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS OR LOST SAVINGS) INCURRED FROM THE USE OF OR INABILITY TO USE PRODUCT EVEN IF FUJI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

8. No export.
   You acknowledge that neither Software nor any part thereof, will be transferred, or exported to any country or used in any manner in violation of any export control laws and regulations to which Software is subject.

   In case you breach any of the terms and conditions hereof, Fuji may immediately terminate this Agreement without any notice.

10. Term.
    This Agreement is effective until the date when you cease to use Software, unless earlier terminated in accordance with Section 9 hereof.

11. Obligation upon termination.
    Upon termination or expiration of this Agreement, you shall, at your own responsibility and expense, delete or destroy immediately all Software (including its copies), Media and Documentation.

    This Agreement shall be governed by and construed in accordance with laws of Japan.

Do not attempt to play the CD-ROM enclosed with this product on an audio CD player.
Doing so could damage your hearing or could damage your speakers or headphones.

Please note that this Guide is written on the assumption that you already have a basic understanding of how to use your PC (personal computer), Windows and Macintosh. For basic information on using your PC, Windows and Macintosh, refer to the respective manuals supplied with your PC.

• Microsoft and Windows are trademarks of the Microsoft Corporation of the U.S. registered in the U.S. and other countries.
• Windows is an abbreviated term referring to the Microsoft Windows Operating System.
• Macintosh, iMac, Mac OS and QuickTime™ are registered trademarks of Apple Computer, Inc.
• Adobe Acrobat® Reader™, ActiveShare™ and PhotoDeluxe are trademarks of Adobe Systems Incorporated of the U.S.
• VideoImpression™ is a registered trademark of ArcSoft Inc.
• SmartMedia™ is a trademark of Toshiba Corporation.
• All other company or product names are trademarks or registered trademarks of the respective companies.
Introduction

Glossary of Terms

This section provides explanations of the minimum basic operations you must be familiar with in order to use your personal computer, along with an introduction to some other operations that will help you to use your computer more efficiently. For more detailed information on using your computer, refer to the user manuals supplied with the computer.

■ Application software
Software used for a specific purpose, such as word processing, spreadsheets or image editing.

■ Browser
Software used for viewing web pages on the Internet. Examples include Internet Explorer and Netscape Navigator.

■ Click, Double-click
Click: Pressing the left mouse button (Windows) or the mouse button (Macintosh) once and then releasing it. Used to select files, folders, windows, buttons, etc.
Double-click: Clicking the left mouse button (Windows) or the mouse button (Macintosh) twice. Used to open files, folders, etc.

■ Drive
A peripheral device used by a personal computer to store and access files. A disk drive into which removable media can be loaded is referred to as a removable disk drive. Typical examples include CD-ROM drives and floppy disk drives. Digital cameras are also handled as disk drives.

Drive icons in Windows
Drive icons for Macintosh

■ Driver
Software used by a personal computer to operate a peripheral device.

■ Folder
A location in which related files are stored. Other folders can also be stored inside a folder.

■ Install
The process of setting up software on a personal computer.

■ Menu
A list of functions displayed at the edge of the screen. Typical examples include the “File” and “Edit” menus. When you click on a menu name, a list of the available functions appears and you can then execute a function by moving the mouse to the desired function name.

<Windows> <Macintosh>

■ Server
A computer used on a computer network, such as the Internet, that provides services and data to connected network users.

■ Thumbnail
A reduced image created when images are displayed as a list. In FinePixViewer, double-clicking on a thumbnail image displays the original image.

■ Uninstall
The process of removing software from your PC and restoring your PC’s settings to their original status before the software was installed.
<About the Software>

Digital camera

If the camera’s USB setting is Card Reader.

USB connection

If the camera’s USB setting is PC Camera.

Mass Storage Driver
Allows a digital camera to be used as USB Mass Storage (removable disk drive).

PC Camera Driver
Allows a digital camera to be used as a PC Camera. Some cameras do not support this function.

Exif Launcher
Exif Launcher Launches the FinePixViewer software when a camera is connected.

Personal computer

FinePixViewer
Allows you to display thumbnail lists of the images stored on your PC or in the camera, print the images individually or as an index, display the images at full size and perform some basic image processing.

DP Editor
Software used to read PDF-format documents on a personal computer. This software is needed to read the User’s Guides for FinePixViewer and VideoImpression.

PictureHello
Used for videoconferencing (Windows only)

QuickTime™
Software needed for playing back movies, etc.

Acrobat® Reader™
Software used to read PDF-format documents on a personal computer. This software is needed to read the User’s Guides for FinePixViewer and VideoImpression.

FinePix Internet Service
Users can sign up to get access to a wide range of services.

To sign on as a user, refer to the following pages:
Windows users: P.31
Macintosh users: P.67

Transmission:
Via the Internet

Taking Part in a Videoconference

FinePixViewer

PictureHello

Requirements
• A FUJIFILM camera that has the PC Camera function.
• A connection to the Internet
• A Windows PC with a sound card and a microphone and speakers connected
Installation on a Windows PC

Pre-installation Checklist

- **Hardware and software requirements**
  To run this software, you must have the hardware and software described below. Check your system before you begin the installation.
  
  **Compatible PCs**: IBM PC/AT or compatible*1
  
  *1 Models with USB support as standard are listed below
  
  **Operating System**: Windows 98 (including the second edition)
  Windows Millennium Edition (Windows Me)
  Windows 2000 Professional
  (For installation, log in using the Administrator group.)
  
  **CPU**: 200 MHz Pentium or better
  
  **RAM**: 64 MB minimum
  
  **Hard disk space**: Amount required for installation: 140 MB minimum
  Amount required for operation: 300 MB minimum
  
  **Display**: 800 x 600 pixels or better, 16-bit color or better
  
  **Supported cameras**: Fujifilm digital cameras equipped with a USB interface
  
  **Internet connection***: 56 Kbps modem connection (recommended) or better
  or an ISDN connection
  
  **Sound functions**: Speakers, microphone and sound card
  
  *2: Required to use the FinePix Internet Service and videoconferencing. The software can still be installed even if you do not have an Internet connection.
  
  *3: Cameras that feature the “PC Camera” option in the USB settings allow you to use the videoconferencing functions and the VideoImpression capture function. Sound functions are required for audio input/output in VideoImpression and videoconferencing.

**NOTE**

- Connect the camera/cradle directly to the computer using the special USB cable. The software may not operate correctly if you use an extension cable or connect the camera/cradle via a USB hub.
- If your computer has more than one USB port, the camera can be connected to either port.
- Push the USB connector fully into the socket to ensure that it is securely connected. The software may not operate correctly if the connection is faulty.
- Additional USB interface board is not guaranteed.
- Windows 95 cannot be used.
- Operation is not guaranteed on home-built computers or on computers running updated operating system software.
- Use the drivers (the Mass Storage Driver and PC Camera Driver) provided on the enclosed CD-ROM. When older drivers are already installed on your PC, uninstall the old versions and then re-install the drivers provided on the enclosed CD-ROM.
- If your Internet connection is via a router or LAN, you may not be able to use the videoconferencing functions.

Installing the Software

- **The following applications are installed by the Installer:**
  - FinePixViewer
  - DP Editor
  - Exif Launcher
  - QuickTime™
  - NetMeeting 3.01 (Windows 98 computers must upgrade to this version.)
  - VideoImpression™
  - Windows Media Player
  - Acrobat® Reader™
  - ActiveShare™
  - PhotoDeluxe

**Installation Preparations**

Have the Owner’s Manual for your camera handy and read it in conjunction with these instructions.

1. **Switch on your PC and start up Windows.**
   * If you are using Windows 2000 Professional, log on as an Administrator group.

2. **Quit all other active applications until no applications are shown in the taskbar.**
   1. Click the right mouse button on the application icon in the taskbar.
   2. Click “Close” in the menu that appears to quit the application.
   * Refer to the instructions provided with your PC and applications (antivirus software, etc.) for details.

3. **If the following applications are installed on your PC, use “Add/Remove Programs” in the Control Panel to uninstall the applications. (See P.46.)**
   - Exif Viewer
   - Exif Launcher
   - DP Editor

4. **Load the enclosed CD-ROM into the CD-ROM drive. The installer starts up automatically.**
   * If the installer does not start up automatically, see “Launching the Installer Manually” on the next page.
1. The Setup screen appears. Click the “Install FinePixViewer” button.

2. A list of the applications to be installed appears. Check the list and then click [OK].

3. Use the procedure given below to install each of the listed applications. When installation of an application is completed, installation of the next application begins automatically.

   ① Check the notes and warnings. Notes and warnings are displayed relating to the applications being installed. Check the details and then click the [Next >] button.

---

**Launching the Installer Manually**

1. Double-click the “My Computer” icon.

2. Double-click “PHOTODELUXE (D:)” in the “My Computer” windows.
   * (Here, “D:” is the designation for the CD-ROM drive.)


---

**Starting the Installation**

Notes on Installing QuickTime

When the “User Registration” window opens during installation, you can complete the installation without entering any data.
Select the installation destination. An installation destination window is displayed. You can change the installation destination by clicking the [Browse…] button. Check the destination and then click the [Next >] button.

Installation
The installation (copying files, changing settings, etc.) begins automatically.

Complete the installation. When installation ends, a confirmation window appears. Click the [OK] button to proceed to the next installation. (This procedure begins again automatically from step 1.)

Finally, the restart window appears. Click the “Restart” button.
* FinePixViewer installation is not completed until you restart your computer.

After you restart your computer, follow the procedure on P.12 to start up the Installer manually.
Use the same procedure to install “Acrobat Reader”.
* To read the FinePixViewer User’s Guide (PDF), you must have “Acrobat Reader” from Adobe Systems, Inc. installed.
* Acrobat Reader installation does not require a restart.

Use the same procedure to install “PhotoDeluxe” and “ActiveShare”.
* When you have finished installing “ActiveShare”, you may be asked to restart your computer. In this case, begin installing “PhotoDeluxe” without restarting your computer.

NOTE
If a “----.dll file not found.” message appears during installation, there is another application running in the background (a screen saver or similar application that could not be shut down in step 1). Forcibly shut down the application. Refer to your Windows manuals for information on how to forcibly shut down an application.

The User’s Guide (PDF) and How to Read It

To read the FinePixViewer User’s Guide (PDF), you must have Adobe Systems’ “Acrobat Reader” installed on your computer. See P.14 for information on installing Acrobat Reader.

Reading the User’s Guide
1. Select “Start” → “Programs” → “FinePixViewer” and click “English.pdf”.
   * “Acrobat Reader” starts up and displays the User’s Guide.
2. To jump to the relevant page, click the desired topic listed in the Contents or Bookmarks.
   * To view the bookmarks, click “Show Bookmarks” in the Window menu.
   * For more information on how to use Acrobat Reader, refer to the Online Guide in the Acrobat Reader Help menu.

Printing the User’s Guide
1. Click “Page Setup” in the File menu and specify the required settings (“Paper”, “Layout”, etc.).
   * If you print the manual at the original dimensions, each page fits on one sheet of A4 paper in Portrait layout.
2. Click the [Print] button or select “Print” in the File menu.
3. Specify the range of pages to be printed and the number of copies, etc. and then click [OK].

NOTE
* The available options vary depending on your printer and printer driver software. Refer to your printer driver manual for details.
* For more information, refer to the Online Guide in the Acrobat Reader Help menu.
Installing the Mass Storage Driver

Installing Mass Storage Driver allows you to transfer files recorded on the camera to your PC.

1. **Switch on your PC and start up Windows.**
   - If you are using Windows 2000 Professional, log on as an Administrator group.

2. **Double-click “My Computer”.**
   - When installation is completed, a new removable disk icon (the connected camera) [ ] is added.

3. **Insert the enclosed CD-ROM into the CD-ROM drive.**
   - If the installation screen for the applications provided on the CD-ROM appears, click the [Exit] button to exit the screen.

4. **Select the camera settings.**
   - If your camera has “DSC (Mass Storage)” and “PC Camera” functions in the USB setting (such as FinePix6800 ZOOM)
     - Load a SmartMedia containing images you have shot into the camera. Select “DSC” in the camera’s USB setting.
   - If your camera has only the “DSC (Mass Storage)” function in the USB setting
     - Load a SmartMedia containing images you have shot into the camera.

   **NOTE**
   - Refer to “PC Connection” in the Owner’s Manual for your camera for more information on camera operation and the USB setting.
   - Use only SmartMedia containing images shot on a FUJIFILM digital camera.
   - It is strongly recommended that you connect the AC power adapter when you are using a USB connection to avoid loss of power while you are using the camera.

5. **Using the enclosed USB cable, connect the camera (or the cradle) to the USB port on your computer and then switch the camera on.**

6. **A message appears in the “New Hardware” dialog box indicating that “USB Mass Storage” has been detected.**
   - See P.19, if you are using Windows Millennium Edition.
   - See P.20, if you are using Windows 2000 Professional.

Windows 98/98SE

7. **The “Add New Hardware Wizard” dialog appears. Click [Next >].**

   **NOTE**
   - If the dialog box does not appear, uninstall and then re-install the Mass Storage Driver. (See P.16, 45.)

8. **Select “Search for the best driver for your device (Recommended)” and click [Next >].**

9. **In the next window, tick “CD-ROM drive” and click the [Next >] button.**

   **NOTE**
   - The dialog shown may differ slightly on some types of PC.
10. Check that USBS04CB.INF has been detected and then click [Next >].

7. The “Add New Hardware Wizard” dialog opens. Click the [Next >] button.

11. When the window shown at right appears, click the [Finish] button.

8. Select “USB Mass Storage” on the same line as “USBDRV\WINMEUFLT04CB.INF” on the CD-ROM and then click the [OK] button.

12. Installation is completed when a new removable drive icon (the connected camera) \[\text{[\phantom{0}]}\] appears in the “My Computer” window.

9. When you click the [Finish] button, the “New Hardware” dialog box appears. Wait until the dialog box disappears.

When [\[\phantom{0}\]] does not appear

1. First uninstall Mass Storage Driver. (See P.45.)
2. Re-install Mass Storage Driver. (See P.16.)

Windows Millennium Edition (Windows Me)

10. Installation is completed when a new removable drive icon (the connected camera) \[\text{[\phantom{0}]}\] appears in the “My Computer” window.

NOTE

- It may take a few minutes for the dialog box shown at right to appear after “USB Mass Storage” is detected.
- If the dialog box does not appear, uninstall and then re-install the Mass Storage Driver. (See P.16, 45.)

When [\[\phantom{0}\]] does not appear

1. First uninstall Mass Storage Driver. (See P.45.)
2. Re-install Mass Storage Driver. (See P.16.)

Click here.

Check the file name.
7. The “Found New Hardware Wizard” dialog opens. Click the [Next >] button.

**NOTE**
If the dialog box does not appear, uninstall and then re-install the Mass Storage Driver. (See P.16, 45.)

8. Select “Search for a suitable driver for my device (recommended)” and then click [Next >].

9. In “Optional search locations”, tick “CD-ROM drives” and then click [Next >].

* The screen shown may differ slightly depending on the type of computer.

10. Check that USBS04CB.INF has been detected and then click [Next >].

11. When driver installation is completed, the screen shown at right appears. Click the [Finish] button.

12. Installation is completed when a new removable drive icon (the connected camera) appears in the “My Computer” window.

When [ ] does not appear
1. First uninstall Mass Storage Driver. (See P.45.)
2. Re-install Mass Storage Driver. (See P.16.)
Installing the PC Camera Driver

If your camera has a “PC Camera” function in the USB setting, installing PC Camera Driver allows you to import live images from the camera.

✽ Use PictureHello (see P.34) or VideoImpression (see P.41) to actually view live images.

✽ Here, “live images” refers to the video images shown on the LCD monitor when the camera is set to photography mode.

✽ If you use a camera that does not have the “PC Camera” function in the USB settings, live images cannot be transmitted.

NOTE
The Windows CD-ROM may also be required in some cases. Have the CD-ROM ready beforehand.

1. Switch on your PC and start up Windows.
   ✽ If you are using Windows 2000 Professional, log on as an Administrator group.
   ✽ Do not connect other video capture equipment to your PC.

2. Insert the enclosed CD-ROM into the CD-ROM drive.
   If the installation screen for the applications provided on the CD-ROM appears, click the [Exit] button to exit the screen.

3. Select “PC Camera” in the camera’s USB setting.

   NOTE
   • Refer to “PC Connection” in the Owner’s Manual for your camera for more information on camera operation and the USB setting.
   • It is strongly recommended that you connect the AC power adapter when you are using a USB connection to avoid loss of power while you are using the camera.

4. Using the enclosed USB cable, connect the camera (or the cradle) to the USB port on your computer and then switch the camera on.

5. A message appears in the “New Hardware” dialog box indicating that “USB PC Camera” has been detected.

   ✽ See P.25, if you are using Windows Millennium Edition.
   ✽ See P.26, if you are using Windows 2000 Professional.

Windows 98/98SE

6. The “Add New Hardware Wizard” dialog appears. Click the [Next >] button.

NOTE
If the dialog box does not appear, uninstall and then re-install the PC Camera Driver. (See P.22, 45.)

7. Select “Search for the best driver for your device (Recommended)” and click [Next >].

8. In the next window, tick “CD-ROM drive” and click the [Next >] button.

   ✽ The dialog shown may differ slightly on some types of PC.
9. Check that VC4CB104.INF has been detected and then click [Next >].

**NOTE**
The Windows 98 CD-ROM may also be required during installation. In this event, switch CD-ROMs as directed by the on-screen instructions.

10. When driver installation is completed, the dialog shown at right is appears. Click the [Finish] button.

11. FinePixViewer starts up and the “PictureHello” window automatically opens. Check that the live video image is displayed in the “PictureHello” window.

★ If live images are not displayed, installation was not completed successfully. Refer to “Troubleshooting” (P.55).

6. The “Add New Hardware Wizard” dialog opens. Click the [Next >] button.

**NOTE**
- It may take a few minutes for the dialog box shown at right to appear after “USB PC Camera” is detected.
- If the dialog box does not appear, uninstall and then re-install the PC Camera Driver. (See P.22, 45.)
- The Windows Me CD-ROM may also be required during installation. In this event, switch CD-ROMs as directed by the on-screen instructions.

7. When driver installation is completed, the screen shown at right appears. Click the [Finish] button.

8. FinePixViewer starts up and the “PictureHello” window automatically opens. Check that the live video image is displayed in the “PictureHello” window.

★ If live images are not displayed, installation was not completed successfully. Refer to “Troubleshooting” (P.55).
Windows 2000 Professional

6. The “Found New Hardware Wizard” dialog opens. Click the [Next >] button.

**NOTE**
If the dialog box does not appear, uninstall and then re-install the PC Camera Driver. (See P.22, 45.)

7. Select “Search for a suitable driver for my device (recommended)” and then click [Next >].

8. In “Optional search locations”, tick “CD-ROM drives” and then click [Next >].

* The screen shown may differ slightly depending on the type of computer.

9. Check that VC4CB104.INF has been detected and then click [Next >].

10. When the “Digital Signature Not Found” message appears, click [Yes].

**NOTE**
The Windows 2000 Professional CD-ROM may also be required during installation. In this event, switch CD-ROMs as directed by the on-screen instructions.

11. When driver installation is completed, the screen shown at right appears. Click the [Finish] button.

12. FinePixViewer starts up and the “PictureHello” window automatically opens. Check that the live video image is displayed in the “PictureHello” window.

* If live images are not displayed, installation was not completed successfully. Refer to “Troubleshooting” (P.55).
Connecting the Camera and PC and Viewing Images

Have the Owner’s Manual for your camera handy and read it in conjunction with these instructions.

1. Start up your PC and double-click the “My Computer” icon.
   * If you are running Windows 2000 Professional, log on using the user account you normally use.

2. Select the camera settings.
   - If your camera has “DSC (Mass Storage)” and “PC Camera” functions in the USB setting (such as FinePix6800 ZOOM)
     Load a SmartMedia containing images you have shot into the camera. Select “DSC” in the camera’s USB setting.
   - If your camera has only the “DSC (Mass Storage)” function in the USB setting
     Load a SmartMedia containing images you have shot into the camera.

   **NOTE**
   - It is strongly recommended that you connect the AC power adapter when you are using a USB connection to avoid loss of power while you are using the camera.
   - Refer to “PC Connection” in the Owner’s Manual for your camera for more information on camera operation and the USB setting.
   - Use only SmartMedia containing images shot on a FUJIFILM digital camera.

3. Using the enclosed USB cable, connect the camera (or the cradle) to the USB port on your computer and then switch the camera on.
   ✽ When the “Removable Drive” icon appears in the “My Computer” window, the camera and PC are correctly connected.

---

### To View Images Using FinePixViewer

**Launch FinePixViewer.**

If you are running Exif Launcher

When you connect the camera (or the cradle) to the USB port on your PC, Exif Launcher starts up FinePixViewer.
* If you have altered the Exif Launcher settings, FinePixViewer will not start up.

If you are not running Exif Launcher

Select “Programs” → “FinePixViewer” → “FinePixViewer” in the “Start” menu. FinePixViewer then starts up.

**NOTE**
- If FinePixViewer is slow to start up, refer to “Troubleshooting” (P.52).

**Exif Launcher**

- When you install Exif Launcher, it is registered in the startup menu and is launched automatically when Windows starts up.
- If the icon in the figure is shown in the taskbar, Exif Launcher is running.
- To quit Exif Launcher, click the right mouse button on the [ ] icon in the taskbar and select “Exit” from the menu that appears.
  ✽ When you quit Exif Launcher, the icon will disappear from the taskbar.

**<FinePixViewer startup window>**

![Thumbnail display area](thumbnail_display_area)

- Thumbnail images for the image data recorded on the SmartMedia are displayed in the thumbnail display area.

![This thumbnail indicates an audio file.](audio_file_thumbnail)

When you double-click a thumbnail, the image is displayed in a new image window.

To close the image window, click the [Close] [ ] button in the top-right corner of the window.

You can copy an image and save it to the hard disk of your PC by dragging its thumbnail and dropping it onto the desktop or into a folder.
* For detailed information on using the FinePixViewer and DP Editor, refer to “English.pdf” in “FinePixViewer” in “Programs” in the “Start” menu.
To Disconnect the Camera

1. **To exit FinePixViewer, select “Exit” from the “File” menu or click the [Close] button in the main window.**

2. **Check that the camera display indicates that data access is no longer in progress.**
   - On Windows 2000 Professional and Windows Me, click the eject icon [ ] on the taskbar when the camera display indicates that data access is no longer in progress and remove “USB Mass Storage” or “USB Disk”.

3. **Disconnect the camera.**

**NOTE**
- Do not perform the operations listed below when a camera (removable disk) file is open and the camera display indicates that data access is in progress. Performing any of these operations could corrupt the data on the SmartMedia or damage the SmartMedia itself.
  - Switch the camera off/Touch any of the camera control buttons/Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia cover/Remove the camera batteries/Remove the camera from the cradle
  - Do not use your computer to format the SmartMedia in the camera as this may make the card unusable for taking pictures.

---

### Using the FinePix Internet Service

If you use the FinePixViewer, you can also access the FinePix Internet Service via the Internet.

When you register, you will be able to use the various services provided in the country where you are registered.
- The services provided vary depending on the country.
- The services are frequently updated, so we recommend that you access them regularly.
- In order to access the service you need to have an internet connection, provided by an ISP (Internet Service Provider.)
- You must have the hardware and software required for connecting to the Internet.
- The FinePix Internet Service does not include any connection fees charged by your service provider or the normal telephone charges for dialing your service provider’s access number.

### User Registration

To use the FinePix Internet services, users must first register.
* Follow the steps below to register. Users can be registered for free.

1. **Select “Programs” → “FinePixViewer” → “FinePixViewer” in the “Start” menu to launch FinePixViewer.**

2. **Click the “User’s Registration” button. The operation selection dialog box appears.**

3. **Select “User’s registration” and click the [OK] button.**
   - If you are not already connected to the Internet, connect at this point. (A dial-up dialog box may be displayed.)
   - Only select menu acquisition if you have already completed the user registration process and you have re-installed “FinePixViewer”, etc.
4. The User’s Registration dialog box opens.
Select the country or area where you are living and click the [OK] button.
The browser starts up and opens the user registration page. Use this page to register as a user.
* After you register, a confirmation e-mail message is sent to you. Be sure to enter a valid e-mail address at which you can receive the message.
* The actual user registration page may differ slightly in appearance from the sample shown here.
* If the country or area where you are living does not appear in the pull-down list, select “OTHERS”. A button linking to the English home page for FUJI PHOTO FILM CO. LTD. (TOKYO, JAPAN) will be displayed.

Important Information for Internet Users

■ Viruses
A virus infecting your PC can result in the loss of important data or the sending of unwanted e-mail messages to the people stored in your address book. Do not open downloaded files or files received as e-mail attachments unless you are certain of their content.

■ Private Information
If you send a message to the other party during a videoconference, the message is not encoded. Take care not to send important information such as telephone or credit card numbers.

Using the Services

Once user registration is completed, you can use the FinePix Internet services.

1. Selecting services

1. Click the menu button for the service you want to use.
   * If you are not already connected to the Internet, the software automatically attempts to connect (for dial-up connections).
   * Operation after you click the menu button differs depending on the button you click. For instance, you may jump to your service provider’s web site or an upload dialog box may open.
   * The actual Internet menu may differ slightly in appearance from the sample shown here.

   TIP
   Move the mouse cursor over an Internet menu button to view information about the service.

2. When you have finished using the Internet services, disconnect from the Internet (for dial-up connections).

   NOTE
   The connection speed will vary significantly depending on the quality of your phone line and the amount of traffic on the server to which you are connected.

■ Updating the Menu

1. Select “Menu Update” from the “View” menu.

2. The User Verification dialog box appears.
Enter the user ID and password set during user registration and then click the [OK] button to update the Internet menu.

   TIP
   As well as the Internet menu being updated, related information pages may also be opened. Because these pages may contain good news or useful information, you should update the Internet menu frequently.

TIP

The connection speed will vary significantly depending on the quality of your phone line and the amount of traffic on the server to which you are connected.
Videoconferencing Using PictureHello

What is videoconferencing?
Videoconferencing is a form of communication in which you can see a live image of the person you are calling as you converse in realtime. This explanation describes the use of the FinePixViewer PictureHello software, in which specific PCs communicate with each other (one-to-one communication) via the Internet.

Hardware and software required for videoconferencing
- A FUJIFILM camera equipped with the “PC Camera” function
- A PC with an Internet connection
  - 56Kbps modem connection or better or an ISDN connection
  - An established service contract with an Internet service provider (ISP)
  - Depending on your type of Internet connection and/or your modem connection speed, video quality may deteriorate and some frames may be lost.
  - A sound card installed and speakers and a microphone connected to your PC
  - PCs that do not have a sound card installed and speakers and a microphone connected can only be used to transmit images.
  - You cannot use videoconferencing if you are connected to the Internet via a router or via a LAN (using an external connection from the LAN).
  - For the best results, use headphones with an attached microphone.
- FinePixViewer and NetMeeting 3.01 installed
- A completed FinePix Internet Service user registration
  - When the user registration button [ ] is displayed on the right side of the FinePixViewer window, you must complete the user registration procedure.
    (See P.31.)

Name | Explanation
--- | ---
1 Connection icon | Indicates whether you are logged in to the server.
2 Login button | Logs in to the server.
3 Logout button | Logs out from the server.
4 Start Call button | Notifies the other party that the call has begun.
5 End Call button | Ends a call.
6 Close button | Exits PictureHello.
7 Address Book button | Opens the address book.
8 Address input field | Used for specifying the party to be called.
9 Capture button | Pauses the video image of the other party and saves the paused frame as a still image.
10 Remote party information | Reflects the information in the address book.
11 Own information | E-mail address used at user registration.
12 Message to other party | Message entered during login.
13 Answer automatically | Tick this checkbox to begin videoconferencing automatically.
14 Bandwidth (network speed) | Select the network connection speed used for calls from this list. If you change the bandwidth, you must then restart FinePixViewer.
15 “Pause” | If you uncheck this item, the live image on your screen begins to move. When you want to check whether the live image is displayed correctly, uncheck this item. (“Pause” is unchecked automatically during calls.)
16 Items other than “Pause” and “Copy” | PictureHello automatically selects the optimum setting. Ordinarily, these settings can be ignored.

Portrait images are inset composite images.
Preparations for videoconferencing (to be followed by both parties)

1. Exchange e-mail address (the address used at FinePix Internet Service user registration) and store the other party’s e-mail address in your PictureHello address book.

2. Select “PC Camera” in the camera’s USB settings. Use the special USB cable to connect the camera to the USB port on your PC and then switch the camera on. Check that FinePixViewer has started up and the “PictureHello” window has opened automatically.
   - To open the PictureHello window manually, select “Open Window” from the “Videoconference” menu in FinePixViewer.
   - If a video input device other than the camera is connected to your PC, disconnect the video input device and then reconnect the camera.
   - You cannot use PictureHello and NetMeeting concurrently. If you are using PictureHello, do not launch NetMeeting.
   - Refer to “PC Connection” in the Owner’s Manual for your camera for more information on camera operation and the USB settings.

NOTE
- Do not switch off the camera or disconnect the USB cable during live image display as this may cause your PC to hang.
- It is strongly recommended that you connect the AC power adapter during videoconferencing to prevent the camera from switching off.
- If the “PictureHello” window does not open, check the following:
  1. Is “PC Camera” selected in the USB settings on the camera?
  2. Is the USB cable connected correctly?
If the problem is not caused by either of these, refer to “Troubleshooting” (P.55).
- If no live image is displayed, right-click in the live image display area and uncheck “Pause image” in the menu. (See P.33.)

3. Log in.
   - If your system is set up to automatically connect to the Internet
     Click the [ ] (Login) button.
   - If your system is set up for manual connection to the Internet
     Connect to the Internet and then click the [ ] (Login) button.

4. A message input dialog box opens. Type in a message to the other party and click the [OK] button.
   - When you are successfully logged in, the [ ] connection icon changes to indicate a call in progress.

NOTE
- Messages are sent without being encoded. Do not include sensitive information in your message.
- To change the message, you must log out and then log in again.

Starting the call

1. Click the Address Book button to open the Address Book.

2. Click the Update Status button in the Address Book to check the status of the party you are calling.
   - If the other party is available
     Click the information column for the other party to select him or her and then click the Call button.
   - The call begins when the other party replies.
   - If the other party is unavailable
     1. Stay logged on and wait a few minutes.
     2. Click the status update button in the Address Book to check the status of the other party.
     3. Repeat steps 1 and 2 until the other party becomes available. If you decide not to call, see “Ending the Videoconference” on P.38.

When a call comes in

A confirmation dialog box appears. Click [Yes] to begin the call.
   - If you click [No], the call does not begin. The caller sees a message stating, “The other party cannot receive calls.”

TIP
If you tick the “Automatically accept incoming calls” checkbox, no confirmation message is displayed and the call begins automatically.

Saving a Caller’s Image

1. When you click the [ ] (Capture) button during a call, the “Remote party information” image is updated.
2. A dialog box to confirm the save destination appears. When you select “Paste to address book” and click the [OK] button, the image in the address book is updated.
* If you accept a call, you can only select “Copy to Clipboard” during the call.

**Ending a Call**
Click the [ ] (End Call) button.

---

**Using the Address Book**
Clicking the [ ] (Address Book) button opens the address book.

- Press the [ ] (Capture) button to store or update.
- Update Status button
To check the most recent status, click the Update Status button.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Can be called?</th>
<th>Status of other party</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Not logged in.</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Logged in.</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>Logged in but busy with another call.</td>
<td></td>
</tr>
<tr>
<td>Unclear</td>
<td>Unclear. Click the Update Status button.</td>
<td></td>
</tr>
</tbody>
</table>

To add a new address or edit an existing address, click the New or Edit button. Enter or modify each item and then click the [OK] button.

---

**Ending the Videoconference**

1. When you click the [ ] (Logout) button, the connection to the server is ended.

2. To exit PictureHello, click the [ ] (Close) button.

---

**NOTE**
If you are using a dial-up connection, logging out does not disconnect you from the Internet. If you have finished using the Internet, disconnect manually.
Using VideoImpression

You can use VideoImpression to make your own movies.  
For more information on VideoImpression, refer to the contact information provided on the back cover of this manual.

**Main Functions**

- Allows you to create and save movies that include both still and moving images and sound.  
- Allows you to edit your movies so you can cut unwanted scenes or add captions.   
- Provides effective ways of switching from one scene to another (transitions).  
* More information on these functions and how to use them is available as follows:  
  - Open the “English.pdf” file in the “Manual” folder inside “Vimpress” on the enclosed CD-ROM.  
  - Check on the Internet by clicking the link in the bottom right corner of the screen.  
  - Use the contact details printed on the back cover to contact FUJIFILM.

**Making Your Own Movies**

### Store the movie in an album

To work with still images, video and sound, you first have to import them into the album window.

1. In the “Start” menu, select “Programs” → “VideoImpression” → “VideoImpression” to launch VideoImpression.  
2. Click the [new] button to open an album window.  
3. Drag the thumbnails from FinePixViewer and drop them into the album window.
Capturing Live Images

If you are using a camera with the “PC Camera” function in the USB settings, you can import live images from the camera.

✽ It is strongly recommended that you connect the AC power adapter when you are using a USB connection to avoid loss of power while you are using the camera.

✽ Refer to “PC Connection” in the Owner’s Manual for your camera for more information on camera operation and the USB settings.

1. Select “PC Camera” in the camera’s USB settings.

2. Using the special USB cable, connect the camera (cradle) to the USB port on your computer and then switch the camera on. If you have launched FinePixViewer, exit the program.

3. In the “Start” menu, select “Programs” → “VideoImpression” → “VideoImpression”.

4. When the startup screen appears, click the [new] button.

5. When the album window opens, click the [capture] button.

TIP

• If you leave the mouse pointer positioned over a button or image for a few seconds, information about that button or image is displayed.

• In any window, you can access the online help by clicking “?”.

• In addition to “MPEG”, you can choose from a wide range of formats for saved files.

Add a storyboard

In the storyboard, you select the files to be used in the movie and set the order in which the files are played.

1. Add files to the movie by dragging them from the album window and dropping them onto the storyboard.

2. If necessary, you can drag items around in the storyboard to change the playback sequence.

Add text

1. Click the [edit movie] button to switch to the editing window.

2. Click the [text] button and enter the text.
   ✺ You can use the drag handle to adjust the position.

3. Use the buttons below the image to specify settings such as the typeface and the time for which the text appears.

Play back and save the movie

1. Click the [play movie] button to switch to the playback window.

2. Click the Play button and check the movie.

3. When you click the [save] button, the Save dialog box appears. Specify the save location, file name, etc. and save the movie file.
6. The Capture window appears and the live image is displayed.  
   *= Recording has not yet started.

7. Select “USB PC Camera” in the device settings ①.

8. Click the Record button ② to begin recording.

9. Click the Record button ② again to end recording.  
   *= Images have not been saved to a file at this point.

To check the images
Click the Play button ③.

To save the images to a file and return to the Album window
1. When you click the [album] button, the Save dialog box opens. Specify the 
   save destination and click the [OK] button.
2. When the album storage confirmation dialog box appears, click the [OK] 
   button.

NOTE
   • You must have a sound card installed and speakers and a microphone 
     connected to your PC to input and output sound.
   • The time required for playing and saving images varies depending on the 
     performance of your PC.
   • Do not perform any of the following while live images are being displayed: 
     Switch off the camera/Touch any of the control buttons on the camera/ 
     Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia 
     cover/ Remove the camera battery/Remove the camera from the cradle.

Uninstalling Software from a Windows PC

Uninstalling the Driver

■ Uninstall the USB Driver in the following situations:
   • When you have installed Mass Storage Driver but the camera still does not 
     appear as a removable disk icon
   • When you want to remove an unwanted driver
   • When you are upgrading the driver
   • When you have installed the driver but it does not work. (Uninstall the driver 
     and then re-install it.)

1. Switch on your PC and launch Windows.  
   *= If you are using Windows 2000 Professional, log on as an Administrator group.

2. Insert the enclosed CD-ROM into the CD-ROM drive. 
   If the installation screen for the applications provided on the 
   CD-ROM appears, click the [Exit] button to exit the screen.

3. Launch the Uninstaller.  
   For Mass Storage Driver
   Open “My Computer”, right-click the CD-ROM icon and select 
   “Open” to display the contents of the CD-ROM. Double-click 
   “UNIN_MAS.EXE” to remove the installed driver.

   For PC Camera Driver
   Open “My Computer”, right-click the CD-ROM icon and select 
   “Open” to display the contents of the CD-ROM. Double-click 
   “UNIN_PCC.EXE” to remove the installed driver.

4. Reboot your PC to complete the uninstallation process.

NOTE
   • Disconnect the camera beforehand.
   • Close all files when removing drivers.
Uninstalling FinePixViewer, DP Editor and Exif Launcher

You can automatically uninstall these application programs using "Add/Remove Programs" in the Control Panel.

**NOTE**
- Use this procedure only when the installed software is no longer required or when software installation fails.
- Always quit FinePixViewer, DP Editor and Exif Launcher before beginning uninstallation.
- Uninstall Exif Launcher before uninstalling FinePixViewer. Connecting the camera to your PC with only Exif Launcher left installed could cause problems.

1. **Switch on your PC and start up Windows.**
   * If you are using Windows 2000 Professional, log on as an Administrator group.

2. **Open the “My Computer” window and double-click “Add/Remove Programs” in the Control Panel.**

3. **Select the application to be uninstalled.**
   The “Add/Remove Programs Properties” window appears. Select the program to be deleted (FinePixViewer, Exif Launcher or DP Editor) and click the [Add/Remove] button.

4. **Confirm the deletion.**
   A confirmation dialog box appears. Uninstallation cannot be cancelled once it has been confirmed in this dialog box. Check the details carefully.

5. **UninstallShield starts up.**
   When uninstallation ends, click the [OK] button.

---

**Troubleshooting**

If the software does not operate correctly but the problem does not match any of those listed below, check that you are using the correct hardware and software. (See P.10.)

If the problem persists even though you are using the correct hardware and software, refer to the table below and then see the reference page listed for your problem.

<table>
<thead>
<tr>
<th>Problem with</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td>The camera is connected to my PC but the Mass Storage Driver installation will not start.</td>
<td>48</td>
</tr>
<tr>
<td>The camera is connected to my PC but the PC Camera Driver installation will not start.</td>
<td>49</td>
</tr>
<tr>
<td>A message requesting the installation of the Windows CD-ROM appeared while the Mass Storage Driver was being installed.</td>
<td>50</td>
</tr>
<tr>
<td>A message requesting the installation of the Windows CD-ROM appeared while the PC Camera Driver was being installed.</td>
<td>50</td>
</tr>
<tr>
<td>Connection • Image Viewing</td>
<td></td>
</tr>
<tr>
<td>When I connect the camera to my PC, the “Add New Hardware Wizard” appears.</td>
<td>51</td>
</tr>
<tr>
<td>When I double-click the removable disk icon, “The device is not ready” error message appears.</td>
<td>51</td>
</tr>
<tr>
<td>A warning message appeared when I removed the SmartMedia from the camera.</td>
<td>51</td>
</tr>
<tr>
<td>“Device disconnection warning” appears when I disconnect the cable connecting the computer to the camera.</td>
<td>51</td>
</tr>
<tr>
<td>When I disconnect the cable connecting the PC to the camera and double-click the removable disk icon, a message appears and the window does not open.</td>
<td>52</td>
</tr>
<tr>
<td>FinePixViewer automatic startup is slow.</td>
<td>52</td>
</tr>
<tr>
<td>I want to stop the FinePixViewer from launching automatically.</td>
<td>52</td>
</tr>
<tr>
<td>The camera and PC are connected but no removable disk icon is displayed.</td>
<td>53</td>
</tr>
<tr>
<td>The PC hangs when I access the SmartMedia.</td>
<td>54</td>
</tr>
<tr>
<td>Videoconferencing</td>
<td></td>
</tr>
<tr>
<td>The PictureHello (videoconferencing) window does not open.</td>
<td>55</td>
</tr>
<tr>
<td>PictureHello (videoconferencing) does not show video of me.</td>
<td>55</td>
</tr>
<tr>
<td>I clicked the Login button in PictureHello (videoconferencing), but I can’t log in.</td>
<td>56</td>
</tr>
<tr>
<td>The live image of the other party in videoconferencing is very jerky.</td>
<td>56</td>
</tr>
<tr>
<td>There is no live image of the other party during videoconferencing.</td>
<td>56</td>
</tr>
<tr>
<td>Videoconferencing call notifications are not displayed.</td>
<td>56</td>
</tr>
<tr>
<td>I can make calls but I cannot use videoconferencing.</td>
<td>57</td>
</tr>
<tr>
<td>I can’t hear the other party in the videoconference/The other party can’t hear me.</td>
<td>57</td>
</tr>
<tr>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>Live images do not appear in the VideoImpression Capture window.</td>
<td>58</td>
</tr>
<tr>
<td>I can’t log in to the FinePix Internet Service.</td>
<td>59</td>
</tr>
<tr>
<td>I can’t sign on as a FinePix Internet Service user.</td>
<td>59</td>
</tr>
<tr>
<td>My PC does not shut down correctly.</td>
<td>59</td>
</tr>
<tr>
<td>My camera will no longer play back image files.</td>
<td>59</td>
</tr>
<tr>
<td>I can’t play AVI files on Windows MediaPlayer.</td>
<td>59</td>
</tr>
<tr>
<td>I can’t update the Internet menu properly. (The buttons do not line up correctly.)</td>
<td>59</td>
</tr>
</tbody>
</table>
Troubleshooting Installation Problems

- The camera is connected to my PC but the Mass Storage Driver installation will not start.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the camera (cradle) switched on?</td>
<td>Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the &quot;&lt;&quot; button. Refer to the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is “Card Reader” selected as the camera’s USB setting?</td>
<td>Change the camera’s USB setting to “Card Reader”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is the special USB cable connected to the camera (cradle) and to the computer?</td>
<td>Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to the computer.</td>
</tr>
<tr>
<td>Are you using a compatible operating system?</td>
<td>The Mass Storage Driver should be used with Windows 98/98SE, Windows Me or Windows 2000 Professional.</td>
</tr>
<tr>
<td>If you are using Windows 2000 Professional, are you logged on as an Administrator group?</td>
<td>Log on as an Administrator group.</td>
</tr>
<tr>
<td>Is “USB Mass Storage” not listed under “Other Devices” in the Device Manager?</td>
<td>The driver is not installed correctly. Uninstall (see P.45) and then re-install driver.</td>
</tr>
</tbody>
</table>
| Are the USB functions active? Double-click “System” in the Control Panel, select “Device Manager” and check “Universal Serial Bus controllers”. | • If “Universal Serial Bus controllers” is not displayed, the USB functions is disabled. Refer to the User’s Manuals supplied with your PC for details of how to enable the USB functions.  
• If the driver is marked with a yellow “!” or a red “x”, Mass Storage Driver is not running. Uninstall (see P.45) and then re-install Mass Storage Driver. |
| Is an older version of the Mass Storage Driver installed? | Use the CD-ROM provided to uninstall any older versions of the Mass Storage Driver. Then install the new Mass Storage Driver provided on the CD-ROM. |

- The camera is connected to my PC but the PC Camera Driver installation will not start.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the camera (cradle) switched on?</td>
<td>Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the “&lt;” button. Refer to the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is “PC Camera” selected as the camera’s USB setting?</td>
<td>Change the camera’s USB setting to “PC Camera”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is the special USB cable connected to the camera (cradle) and to the computer?</td>
<td>Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to the computer.</td>
</tr>
<tr>
<td>Are you using a compatible operating system?</td>
<td>The PC Camera Driver should be used with Windows 98/98SE, Windows Me or Windows 2000 Professional.</td>
</tr>
<tr>
<td>If you are using Windows 2000 Professional, are you logged on as an Administrator group?</td>
<td>Log on as an Administrator group.</td>
</tr>
<tr>
<td>Is “PC Camera Driver” not listed under “Other Devices” in the Device Manager?</td>
<td>The driver is not installed correctly. Uninstall (see P.45) and then re-install driver.</td>
</tr>
</tbody>
</table>
| Are the USB functions active? Double-click “System” in the Control Panel, select “Device Manager” and check “Universal Serial Bus controllers”. | • If “Universal Serial Bus controllers” is not displayed, the USB functions is disabled. Refer to the User’s Manuals supplied with your PC for details of how to enable the USB functions.  
• If the driver is marked with a yellow “!” or a red “x”, PC Camera Driver is not running. Uninstall (see P.45) and then re-install PC Camera Driver. |
| Is an older version of the PC Camera Driver installed? | Use the CD-ROM provided to uninstall any older versions of the PC Camera Driver. Then install the new PC Camera Driver provided on the CD-ROM. |
Troubleshooting Connection and Image Viewing Problems

■ A message requesting the installation of the Windows CD-ROM appeared while the Mass Storage Driver was being installed.

**Solution**

Refer to the information in the table below to specify the appropriate folder on the Windows CD-ROM.

<table>
<thead>
<tr>
<th>OS Type</th>
<th>Name of Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98</td>
<td>D:\</td>
</tr>
<tr>
<td>Windows Me</td>
<td>D:\Usbdrv\Winme</td>
</tr>
<tr>
<td>Windows 2000 Pro.</td>
<td>D:\</td>
</tr>
</tbody>
</table>

※ When using CD-ROM Drive D

■ A message requesting the installation of the Windows CD-ROM appeared while the PC Camera Driver was being installed.

**Solution**

Refer to the information in the table below to specify the appropriate folder on the Windows CD-ROM.

<table>
<thead>
<tr>
<th>OS Type</th>
<th>Name of Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98</td>
<td>D:\</td>
</tr>
<tr>
<td>Windows Me</td>
<td>D:\</td>
</tr>
<tr>
<td>Windows 2000 Pro.</td>
<td>D:\</td>
</tr>
</tbody>
</table>

※ When using CD-ROM Drive D

Replace the enclosed CD-ROM with the Windows CD-ROM and then refer to the information in the table below to specify the appropriate folder on the Windows CD-ROM.

<table>
<thead>
<tr>
<th>OS Type</th>
<th>Name of Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98</td>
<td>D:\win98</td>
</tr>
<tr>
<td>Windows Me</td>
<td>D:\win9x</td>
</tr>
<tr>
<td>Windows 2000 Pro.</td>
<td>D:\i386</td>
</tr>
</tbody>
</table>

※ When using CD-ROM Drive D

**NOTE**

If no Windows CD-ROM was supplied with your PC, contact your PC manufacturer.

- When I connect the camera to my PC, the “Add New Hardware Wizard” appears.

**Possible cause**

Is the USB Driver installed?

**Solution**

Install the driver. Refer to P.16 and P.22 onwards for the installation procedure.

- When I double-click the removable disk icon, “The device is not ready” error message appears.

**Possible cause**

Is the SmartMedia loaded in the camera?

**Solution**

Load a SmartMedia into the camera. Refer to the Owner’s Manual for your camera for details.

- A warning message appeared when I removed the SmartMedia from the camera.

**Possible cause**

Did you eject the SmartMedia while data access to the camera was still in progress?

**Solution**

This action can damage the SmartMedia and destroy data on the SmartMedia. Always close all the files on the camera (the removable disk) and wait until the camera display indicates that data access is no longer in progress before removing the SmartMedia.

- “Device disconnection warning” appears when I disconnect the cable connecting the computer to the camera.

**Possible cause**

Are you using Windows 2000 Professional or Windows Me?

**Solution**

Before disconnecting the cable, click the “(Eject)” icon in the Taskbar and disconnect the camera.
When I disconnect the cable connecting the PC to the camera and double-click the removable disk icon, a message appears and the window does not open.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is another USB removable drive connected?</td>
<td>Some USB removable drives do not operate correctly if other USB removable drives are being used at the same time. Disconnect all the connected USB removable drives and then connect the camera. However, with some USB storage devices, computer operation may become unstable when the Exit Launcher is resident. See “I want to stop the FinePixViewer from launching automatically” (below) and try removing the Exit Launcher.</td>
</tr>
</tbody>
</table>

FinePixViewer automatic startup is slow.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are you running too many background applications?</td>
<td>Click the “Start” button and select “Programs” → “Startup” from the Start menu. Remove any shortcuts for infrequently used applications from the “Startup” window and then restart your PC.</td>
</tr>
</tbody>
</table>

I want to stop the FinePixViewer from launching automatically.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Are you running too many background applications?       | 1. Click the right mouse button on the Exit Launcher icon in the taskbar and select “Settings” from the pop-up menu.  
   2. Uncheck the “Automatic startup - Media insertion” checkbox.  
   * To restore the original setting, use the same procedure to re-tick the checkbox.  
   
   1. Click the right mouse button on the Exit Launcher icon in the taskbar and select “Quit” from the pop-up menu.  
   2. Click the “Start” button and select “Programs” → “Startup” → “Exit Launcher” from the Start menu. Right-click the “Exit Launcher” icon and select “Remove” from the pop-up menu.  
   * To restore Exit Launcher, create an Exit Launcher shortcut in the “Startup” window. |

The camera and PC are connected but no removable disk icon is displayed.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the camera (cradle) switched on?</td>
<td>Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the “&lt;” button. Refer to the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is the SmartMedia loaded in the camera?</td>
<td>Load a SmartMedia into the camera. Refer to the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is “Card Reader” selected as the camera’s USB setting?</td>
<td>Change the camera’s USB setting to “Card Reader”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is the special USB cable connected to the camera (cradle) and to the computer?</td>
<td>Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to the computer.</td>
</tr>
<tr>
<td>Are you using a compatible operating system?</td>
<td>The Mass Storage Driver should be used with Windows 98/98SE, Windows Me or Windows 2000 Professional.</td>
</tr>
</tbody>
</table>

If you are using Windows 2000 Professional, are you logged on as an Administrator group?

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the Mass Storage Driver running?</td>
<td>Click “System” in the Control Panel, select the Device Manager tab and check the Mass Storage Driver. If the driver is marked with a yellow “!” or a red “x”, Mass Storage Driver is not running. Uninstall (see P.45) and then re-install Mass Storage Driver.</td>
</tr>
</tbody>
</table>

If you are using Windows 2000 Professional, are you logged on as an Administrator group? Log on as an Administrator group.
### Troubleshooting Videoconferencing Problems

#### The PictureHello (videoconferencing) window does not open.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are FinePixViewer and NetMeeting 3.01 installed?</td>
<td>Install FinePixViewer and NetMeeting 3.01 from the enclosed CD-ROM. (See P.13.)</td>
</tr>
<tr>
<td>Is FinePixViewer running?</td>
<td>In the “Start” menu, select “Programs” → “FinePixViewer” and click “FinePixViewer.exe”.</td>
</tr>
<tr>
<td>Is the camera (cradle) switched on?</td>
<td>Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the “&lt;” button. Refer to the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is “PC Camera” selected as the USB setting on the camera?</td>
<td>Change the camera’s USB setting to “PC Camera”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is the special USB cable connected to the camera (cradle) and PC?</td>
<td>Check that one end of the special USB cable is connected to the camera and your PC.</td>
</tr>
<tr>
<td>Is the PC Camera Driver running?</td>
<td>Click “System” in the Control Panel, select the Device Manager and check “USB PC Camera” in “Imaging” or “Other Devices”. If “USB PC Camera” is marked with a yellow exclamation mark “!” or a red cross “x”, it is not running. Uninstall (see P.45) and then re-install PC Camera Driver.</td>
</tr>
</tbody>
</table>

#### The PictureHello (videoconferencing) does not show video of me.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is another video input device connected to your PC?</td>
<td>Disconnect all other video input devices.</td>
</tr>
<tr>
<td>Is another application displaying the live images from the camera?</td>
<td>Quit any other application that is displaying live images.</td>
</tr>
<tr>
<td>Did you disconnect the special USB cable or switch off the camera (cradle) during live image display?</td>
<td>Quit PictureHello and then restart your PC. Check that the special USB cable is connected correctly to the camera and your PC and then switch the camera (cradle) on.</td>
</tr>
</tbody>
</table>

#### The PC hangs when I access the SmartMedia.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When opening the Device Manager, there is a yellow “!” mark next to the driver in “Universal Serial Bus controllers”.</td>
<td>You are using a driver or camera that prevents the driver for the Universal Serial Bus controllers from operating. Check your PC setup.</td>
</tr>
<tr>
<td>When opening the Device Manager, there is a yellow “!” mark next to Mass Storage Driver.</td>
<td>You are using a driver or camera that prevents the Mass Storage Driver from operating. Check your PC setup.</td>
</tr>
<tr>
<td>Is an older version of the Mass Storage Driver software installed?</td>
<td>Use the CD-ROM provided to uninstall any older versions of the Mass Storage Driver. Then install the new Mass Storage Driver provided on the CD-ROM.</td>
</tr>
</tbody>
</table>
### I clicked the Login button in PictureHello (videoconferencing), but I can't log in.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are you able to connect to the Internet?</td>
<td>Check your PC hardware and software setup.</td>
</tr>
<tr>
<td>Is the FinePix Internet Service undergoing maintenance?</td>
<td>Log in after the maintenance is completed.</td>
</tr>
<tr>
<td>Have you completed the user registration process?</td>
<td>Sign on as a FinePix Internet Service user. (See P.31.)</td>
</tr>
</tbody>
</table>

### The live image of the other party in videoconferencing is very jerky.

**Solution**

Use a high-speed line with a connection speed of 56 Kbps or better.

### There is no live image of the other party during videoconferencing.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are you or the other party trying to call outside from an in-house LAN?</td>
<td>Calls cannot be made in either direction between a LAN and an external line. Use a dial-up connection.</td>
</tr>
<tr>
<td>Are you or the other party trying to call outside from a home-office LAN?</td>
<td>Calls cannot be made in either direction between a LAN and an external line. Use a dial-up connection.</td>
</tr>
</tbody>
</table>

### Videoconferencing call notifications are not displayed.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the &quot;Automatically accept incoming calls&quot; checkbox ticked?</td>
<td>Uncheck the &quot;Automatically accept incoming calls&quot; checkbox.</td>
</tr>
<tr>
<td>Are you logged in to the server?</td>
<td>Log in to the server.</td>
</tr>
</tbody>
</table>

### I can make calls but I cannot use videoconferencing.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the other party able to make or accept calls?</td>
<td>Open the address book and click the Update Status button. If the other party cannot accept calls, try again later. (See P.37.)</td>
</tr>
<tr>
<td>Are you or the other party trying to call outside from an in-house LAN?</td>
<td>Calls cannot be made in either direction between a LAN and an external line. Use a dial-up connection.</td>
</tr>
<tr>
<td>Are you or the other party trying to call outside from a home-office LAN?</td>
<td>Calls cannot be made in either direction between a LAN and an external line. Use a dial-up connection.</td>
</tr>
</tbody>
</table>

### I can't hear the other party in the videoconference/The other party can't hear me.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Are the speakers set to playback mode? | You and the other party should use the following procedure to check the speaker setup:
  ①Check that the speakers are connected correctly to your PC.
  ②In the “Start” menu, select “Programs” → “Accessories” → “Entertainment” and click “Volume Control”. Then adjust the volume. |
| Is the microphone operating normally? | You and the other party should use the following procedure to check the microphone setup:
  ①Check that the microphone is connected correctly to your PC.
  ②In the “Start” menu, select “Programs” → “Accessories” → “Entertainment” and click “Sound Recorder”. Then adjust the microphone input level. |
Troubleshooting Other Problems

- Live images do not appear in the VideoImpression Capture window.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do you have Microsoft Media Player installed?</td>
<td>Install Microsoft Media Player from the enclosed CD-ROM. (See P.11.)</td>
</tr>
<tr>
<td>Is the camera (cradle) switched on?</td>
<td>Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the “&lt;” button. Refer to the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is “PC Camera” selected as the USB setting on the camera?</td>
<td>Change the camera’s USB setting to “PC Camera”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is the special USB cable connected to the camera (cradle) and PC?</td>
<td>Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to your PC.</td>
</tr>
<tr>
<td>Is the PC Camera Driver running?</td>
<td>Click “System” in the Control Panel, select the Device Manager and check “USB PC Camera” in “Imaging” or “Other Devices”. If “USB PC Camera” is marked with a yellow exclamation mark “!” or a red cross “x”, it is not running. Uninstall (see P.45) and then re-install PC Camera Driver.</td>
</tr>
<tr>
<td>Is another video input device selected?</td>
<td>Select “USB PC Camera”. Refer to the VideoImpression User’s Guide for information on how to select the video input device.</td>
</tr>
<tr>
<td>Is another application displaying the live images?</td>
<td>Quit any other application that is displaying live images.</td>
</tr>
<tr>
<td>Did you disconnect the special USB cable or switch off the camera (cradle) during live image display?</td>
<td>Quit VideoImpression and then restart your PC. Check that the special USB cable is connected correctly to the camera and your PC and then switch the camera (cradle) on.</td>
</tr>
</tbody>
</table>

- I can’t log in to the FinePix Internet Service.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are you able to connect to the Internet?</td>
<td>Check your PC hardware and software setup.</td>
</tr>
<tr>
<td>Is the FinePix Internet Service undergoing maintenance?</td>
<td>Log in after the maintenance is completed.</td>
</tr>
<tr>
<td>Have you completed the user registration process?</td>
<td>Click the FinePixViewer user registration button and sign on as a FinePix Internet Service user. (See P.31.)</td>
</tr>
</tbody>
</table>

- I can’t sign on as a FinePix Internet Service user.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Have you already signed on under the same e-mail address?</td>
<td>You cannot sign on twice with the same user ID or e-mail address.</td>
</tr>
</tbody>
</table>

- My PC does not shut down correctly.

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disconnect the PC and the camera using the correct procedure and then exit Windows.</td>
</tr>
</tbody>
</table>

*Some types of PC may not shut down correctly while the camera is still connected.*

- My camera will no longer play back image files.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Did you rename any files or folders inside the DCIM folder?</td>
<td>Change the file or folder names in the DCIM folder back to the original names.</td>
</tr>
<tr>
<td>Did you replace an image file inside the DCIM folder?</td>
<td>Do not replace image files in the DCIM folder.</td>
</tr>
</tbody>
</table>

- I can’t play AVI files on Windows MediaPlayer.

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you want to use Windows MediaPlayer, you must install DirectX 8.0. See the Microsoft homepage or industry-related magazines for information on how to acquire DirectX 8.0.</td>
</tr>
</tbody>
</table>

- I can’t update the Internet menu properly. (The buttons do not line up correctly.)

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
</table>
| The menu data is corrupted. Use the procedure below to update the menu:  
① Quit FinePixViewer.  
② From the “Start” menu, select “FinePixViewer” in “Programs”. Then right-click on the “FinePixViewer” icon in the “FinePixViewer” folder and select “Properties”.  
③ Click the “Find link destination” button to display the folder in which FinePixViewer was installed.  
④ Delete the “FinePixInternetFiles” folder in the FinePixViewer installation folder.  
⑤ Launch FinePixViewer and click the Update button. |
Installation on a Macintosh

Pre-installation Checklist

■ Hardware and software requirements
To run this software, you must have the hardware and software described below. Check your system before you begin the installation.

Compatible Mac : Power Macintosh G3*1, PowerBook G3*1, Power Macintosh G4, iMac, iBook or Power Macintosh G4 Cube
*1 Models with a USB port as a standard feature

Operating System : Mac OS 8.6 to 9.1
RAM : 64 MB minimum
Display : 800 × 600 pixels or better, at least 32,000 colors
Hard disk space : Amount required for installation: 70 MB minimum

Amount required for operation: 300 MB minimum

Supported cameras : Fujifilm digital cameras equipped with a USB interface

Internet connection*2: 56 Kbps modem connection (recommended) or better
or an ISDN connection

Sound functions*3 : Speakers, microphone and sound card
*2 Required to use the FinePix Internet Service. The software can still be installed even if you do not have an Internet connection.
*3 Sound functions are required for audio input/output in VideoImpression.

NOTE
• Connect the camera/cradle directly to the Macintosh using the special USB cable. The software may not operate correctly if you use an extension cable or connect the camera/cradle via a USB hub.
• Push the USB connector fully into the socket to ensure that it is securely connected. The software may not operate correctly if the connection is faulty.
• Additional USB interface board is not guaranteed.
• Use the drivers (the Mass Storage Driver and PC Camera Driver) provided on the enclosed CD-ROM. When older drivers are already installed on your PC, uninstall the old versions and then re-install the drivers provided on the enclosed CD-ROM.
• This software is not compatible with Mac OS X.

Installing the Software

Before You Install the Software

1. Switch on your Macintosh and start up Mac OS.

2. Check whether File Exchange is active.

To use a SmartMedia that is supported by the camera, the File Exchange utility supplied with Mac OS must be running. Select the Extensions Manager in the Control Panels and check that the File Exchange check box is ticked. If not, click in the box so that an [X] appears and then restart your Macintosh.

The following applications are installed by the Installer:

FinePixViewer
DP Editor
Exif Launcher
VideoImpression™
QuickTime™
Acrobat® Reader™

* When you install these applications, the following files are installed in the “Extensions” folder:
“USB04CB_StorageShim”, “USB04CB_StorageDriver”, “USB04CB_VcShim” and “USB04CB_VcDriver”
Installation Procedure

1. When you load the enclosed CD-ROM into the CD-ROM drive, the “FinePix” window automatically opens and the “Installer” appears.

   **NOTE**
   If the “FinePix” window does not open automatically, double-click the CD-ROM icon.

2. Double-click “Installer” to launch the Installer.

3. The Installer setup screen appears. Click the [Install FinePixViewer] button.

4. A list of the applications to be installed appears. Check the list and then click [OK].

5. Proceed with the installation as directed by the on-screen instructions.

   * See “Selecting the installation destination” on the next page for information on how to specify the installation destination.

   **Selecting the installation destination**

   ① Click the [Open] button to open the installation destination folder.

   ② To install the software in the displayed folder, click the [Save] button.

6. Use the same procedure to install “Acrobat Reader”.

   * To read the FinePixViewer User’s Guide (PDF), you must have “Acrobat Reader” from Adobe Systems, Inc. installed.

**Notes on Installing QuickTime**

When the “User Registration” window opens during installation, you can complete the installation without entering any data.
Connecting the Camera and Macintosh and Viewing Images

Have the Owner’s Manual for your camera handy and read it in conjunction with these instructions.

1. Start up your Macintosh.
2. Select the camera settings.
   - If your camera has “DSC (Mass Storage)” and “PC Camera” functions in the USB setting (such as FinePix6800 ZOOM)
     Load a SmartMedia containing images you have shot into the camera. Select “DSC” in the camera’s USB setting.
   - If your camera has only the “DSC (Mass Storage)” function in the USB setting
     Load a SmartMedia containing images you have shot into the camera.

   **NOTE**
   - It is strongly recommended that you connect the AC power adapter when you are using a USB connection to avoid loss of power while you are using the camera.
   - Use only SmartMedia containing images shot on a FUJIFILM digital camera.

3. Using the enclosed USB cable, connect the camera (or the cradle) to the USB port on your computer and then switch the camera on.
   - If a removable disk icon appears on the desktop, the camera and Macintosh are correctly connected.

To View Images Using FinePixViewer

Launch FinePixViewer.

**If you are running Exif Launcher**

When you connect the camera (or the cradle) to the USB port on your PC, Exif Launcher starts up FinePixViewer.
- If you changed the Exif Launcher settings, FinePixViewer will not start up.

**If you are not running Exif Launcher**

Double-click the FinePixViewer icon in the installed folder.

**Exif Launcher**

- Exif Launcher starts up automatically when you start up your Macintosh.
- To quit Exif Launcher, select “Exif Launcher Settings” in the “Settings” menu in FinePixViewer and then select “Quit Exif Launcher immediately.”
To use the FinePix Internet services, users must first register.

1. Double-click the FinePixViewer icon in the installed folder.
2. Click the "User's Registration" button. The operation selection dialog box appears.
3. Select “User’s registration” and click the [OK] button.

NOTE
1. To exit FinePixViewer, select “Quit” from the “File” menu or click the Close box in the main window.
2. Drag the “Removable disk” icon on the desktop to the Trash. Alternatively, select the icon and then select “Eject” from the Special menu in the menu bar along the top of the screen.
3. When a message appears indicating that it is OK to remove the card or cable from the camera, disconnect the camera.

NOTE
Switching off the camera or removing the SmartMedia without using the eject procedure described above could damage the SmartMedia or cause your Macintosh to malfunction.
4. The User’s Registration dialog box opens. Select the country or area where you are living and click the [OK] button. The browser starts up and opens the user registration page. Use this page to register as a user.

- After you register, a confirmation e-mail message is sent to you. Be sure to enter a valid e-mail address at which you can receive the message.
- The actual user registration page may differ slightly in appearance from the sample shown here.
- If the country or area where you are living does not appear in the pull-down list, select “OTHERS”. A button linking to the English home page for FUJI PHOTO FILM CO. LTD, (TOKYO, JAPAN) will be displayed.

Using the Services

Once user registration is completed, you can use the FinePix Internet services.

Selecting services

1. Click the menu button for the service you want to use.
   - If you are not already connected to the Internet, the software automatically attempts to connect (for dial-up connections).
   - Operation after you click the menu button differs depending on the button you click. For instance, you may jump to your service provider’s web site or an upload dialog box may open.
   - The actual Internet menu may differ slightly in appearance from the sample shown here.

- The actual Internet menu may differ slightly in appearance from the sample shown here.

TIP

Move the mouse cursor over an Internet menu button to view information about the service.

2. When you have finished using the Internet services, disconnect from the Internet (for dial-up connections).

NOTE

The connection speed will vary significantly depending on the quality of your phone line and the amount of traffic on the server to which you are connected.

Updating the Menu

1. Select “Menu Update” from the “View” menu.

2. The User Verification dialog box appears. Enter the user ID and password set during user registration and then click the [OK] button to update the Internet menu.

- If you are not already connected to the Internet, the software automatically attempts to connect (for dial-up connections).

TIP

As well as the Internet menu being updated, related information pages may also be opened. Because these pages may contain good news or useful information, you should update the Internet menu frequently.

Important Information for Internet Users

Viruses
A virus infecting your PC can result in the loss of important data or the sending of unwanted e-mail messages to the people stored in your address book. Do not open downloaded files or files received as e-mail attachments unless you are certain of their content.
Using VideoImpression

You can use VideoImpression to make your own movies. For more information on VideoImpression, refer to the contact information provided on the back cover of this manual.

Main Functions

- Allows you to create and save movies that include both still and moving images and sound.
- Allows you to edit your movies so you can cut unwanted scenes or add captions.
- Provides effective ways of switching from one scene to another (transitions).

TIP

- If you leave the mouse pointer positioned over a button or image for a few seconds, information about that button or image is displayed.
- In any window, you can access the online help by clicking “?”. For information on using the screens, refer to “English.pdf” in “Manual” in the “Vimpress” folder on the enclosed CD-ROM.

Making Your Own Movies

Store the movie in an album

To work with still images, video and sound, you first have to import them into the album window.

1. Double-click the VideoImpression in the folder in which VideoImpression was installed to launch VideoImpression.

2. Click the [new] button to open an album window.

3. Drag the thumbnails from FinePixViewer and drop them into the album window.
**Capturing Live Images**

If you are using a camera with the “PC Camera” function in the USB settings, you can import live images from the camera.

- It is strongly recommended that you connect the AC power adapter when you are using a USB connection to avoid loss of power while you are using the camera.
- Refer to “PC Connection” in the Owner’s Manual for your camera for more information on camera operation and the USB settings.

1. Select “PC Camera” in the camera’s USB settings.
2. Using the special USB cable, connect the camera (cradle) to the USB port on your computer and then switch the camera on. If you have launched FinePixViewer, exit the program.
3. Double-click the VideoImpression icon in the folder in which VideoImpression was installed.
4. When the startup screen appears, click the [new] button.
5. When the album window opens, click the [capture] button.

**NOTE**
- You must have a sound card installed and speakers and a microphone connected to your PC to input and output sound.
- The time required for playing and saving images varies depending on the performance of your PC.
- Do not perform any of the following while live images are being displayed: Switch off the camera/Touch any of the control buttons on the camera/Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia cover/Remove the camera battery/Remove the camera from the cradle.
- In addition to “MPEG”, you can choose from a wide range of formats for saved files.

**Add a storyboard**

In the storyboard, you select the files to be used in the movie and set the order in which the files are played.

1. Add files to the movie by dragging them from the album window and dropping them onto the storyboard.
2. If necessary, you can drag items around in the storyboard to change the playback sequence.

**Add text**

1. Click the [edit movie] button to switch to the editing window.
2. Click the [text] button and enter the text.
3. Use the buttons below the image to specify settings such as the typeface and the time for which the text appears.

**Play back the movie**

1. Click the [play movie] button to switch to the playback window.
2. Click the Play button and check the movie.

**NOTE**
- You must have a sound card installed and speakers and a microphone connected to your PC.
- The time required for playing and saving images varies depending on the performance of your PC.
- Do not perform any of the following while live images are being displayed: Switch off the camera/Touch any of the control buttons on the camera/Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia cover/Remove the camera battery/Remove the camera from the cradle.
- In addition to “MPEG”, you can choose from a wide range of formats for saved files.
6. The Capture window appears and the live image is displayed.
   * Recording has not yet started.

   ![Capture window]

7. Click the [Capture Video] button to begin recording the movie.
   ※ The name of the button changes to [Stop Capture]. During recording, only the [Stop Capture] button can be pressed.

   ![Movie recording in progress]  ![<Standby>]

8. Click the [Stop Capture] button to stop recording. The movie data will be automatically saved to a file and imported to the Album.

9. Click the [Done] button to return to the Album window.

   ![Video setting]  ![Stop Live]  ![Stop Capture]

NOTE
- You must have a sound card installed and speakers and a microphone connected to your PC to input and output sound.
- The time required for playing and saving images varies depending on the performance of your PC.
- Do not perform any of the following while live images are being displayed: Switch off the camera/Touch any of the control buttons on the camera/Disconnect the USB cable/Remove the SmartMedia/Open the SmartMedia cover/Remove the camera battery/Remove the camera from the cradle.

Uninstalling the Software on a Macintosh

Use this procedure only when the installed software is no longer required or when software installation fails.

Uninstalling Mass Storage Driver and PC Camera Driver
First, check that the digital camera is no longer connected. Then open the Extensions folder on the hard disk and move the following four files to the Trash:
“USB04CB_StorogeShim”
“USB04CB_StorogeDriver”
“USB04CB_VcShim”
“USB04CB_VcDriver”
Then, restart your Macintosh and select “Empty Trash” from the Special menu.

Uninstalling Exif Launcher, FinePixViewer and DP Editor
1. After you have quit Exif Launcher in “Exif Launcher Settings” in the FinePixViewer “Settings” menu, move the Exif Launcher file from the “Startup Items” folder in the System folder to the Trash. Then select “Empty Trash” in the “Special” menu.

2. Quit FinePixViewer and DP Editor and move the FinePixViewer and DP Editor files to the Trash. Then select “Empty Trash” from the Special menu.
## Troubleshooting

If the software does not operate correctly but the problem does not match any of those listed below, check that you are using the correct hardware and software. (See P.60.) If the problem persists even though you are using the correct hardware and software, refer to the table below and then see the reference page listed for your problem.

### Connection and Image Viewing Problems

- **The message, “The software needed cannot be found.”, appeared when I connected the camera to my Macintosh.**

  **Problem**
  - The message, “The software needed cannot be found.”, appeared when I connected the camera to my Macintosh.
  - When I connected the USB cable, Mac OS displayed the “Initialize disk?” message.
  - The camera and PC are connected but no removable disk icon is displayed.
  - A warning message appears when I remove the SmartMedia or disconnect the USB cable from the camera.

  **Solution**
  - Install the software on your PC.

- **The PC hangs when I access the SmartMedia.**

  **Problem**
  - Is the software installed?
  - Is the camera (cradle) switched on?
  - Is the SmartMedia loaded in the camera?
  - Is “Card Reader” selected as the camera’s USB setting?
  - Is the special USB cable connected to the camera (cradle) and to the computer?
  - Are you using a compatible operating system?
  - Is the Mass Storage Driver active?

  **Solution**
  - Install the software on your PC.
  - Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the “*” button. Refer to the Owner’s Manual for your camera for details.
  - Load a SmartMedia into the camera. Refer to the Owner’s Manual for your camera for details.
  - Change the camera’s USB setting to “Card Reader”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.
  - Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to the computer.
  - The USB Driver should be used with Mac OS 8.6 to 9.1. (It is not compatible with Mac OS X.)
  - Enable “USB04CB_StorageShim” and “USB04CB_StorageDriver” in the Extensions Manager and restart your Macintosh.

### Internet Problems

- **I can’t log in to the FinePix Internet Service.**

  **Problem**
  - I can’t log in to the FinePix Internet Service.
  - I can’t sign on as a FinePix Internet Service user.
  - I can’t update the Internet menu properly. (The buttons do not line up correctly.)
  - The FinePixViewer Upload dialog box does not appear.
  - The “Process aborted because error occurred during communication” message appears while you are using the FinePixViewer Upload dialog box.

  **Solution**
  - Install the software on your PC.
  - Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to the computer.

### Other Problems

- **Live images do not appear in the VideoImpression Capture window.**

  **Problem**
  - Live images do not appear in the VideoImpression Capture window.
  - My camera will no longer play back image files.
  - I want to stop the FinePixViewer from launching automatically.

  **Solution**
  - The USB Driver should be used with Mac OS 8.6 to 9.1. (It is not compatible with Mac OS X.)
  - Enable “USB04CB_StorageShim” and “USB04CB_StorageDriver” in the Extensions Manager and restart your Macintosh.

- **The message, “The software needed cannot be found.”, appeared when I connected the camera to my Macintosh.**

  **Problem**
  - Is the software installed?
  - Is the camera (cradle) switched on?
  - Is the SmartMedia loaded in the camera?
  - Is “Card Reader” selected as the camera’s USB setting?
  - Is the special USB cable connected to the camera (cradle) and to the computer?
  - Are you using a compatible operating system?
  - Is the Mass Storage Driver active?

  **Solution**
  - Install the software on your PC.
  - Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the “*” button. Refer to the Owner’s Manual for your camera for details.
  - Load a SmartMedia into the camera. Refer to the Owner’s Manual for your camera for details.
  - Change the camera’s USB setting to “Card Reader”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.
  - Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to the computer.
  - The USB Driver should be used with Mac OS 8.6 to 9.1. (It is not compatible with Mac OS X.)
  - Enable “USB04CB_StorageShim” and “USB04CB_StorageDriver” in the Extensions Manager and restart your Macintosh.
Troubleshooting Internet Problems

I can’t log in to the FinePix Internet Service.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are you able to connect to the Internet?</td>
<td>Check your PC hardware and software setup.</td>
</tr>
<tr>
<td>Is the FinePix Internet Service undergoing maintenance?</td>
<td>Log in after the maintenance is completed.</td>
</tr>
<tr>
<td>Have you completed the user registration process?</td>
<td>Click the FinePixViewer user registration button and sign on as a FinePix Internet Service user. (See P.67.)</td>
</tr>
</tbody>
</table>

I can’t sign on as a FinePix Internet Service user.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Have you already signed on under the same e-mail address?</td>
<td>You cannot sign on twice with the same user ID or e-mail address.</td>
</tr>
</tbody>
</table>

I can’t update the Internet menu properly. (The buttons do not line up correctly.)

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The menu data is corrupted. Use the procedure below to update the menu:</td>
</tr>
<tr>
<td>① Quit FinePixViewer.</td>
</tr>
<tr>
<td>② Double-click “System Folder” and then “Preferences” to open the Preferences folder.</td>
</tr>
<tr>
<td>③ Trash the “FinePixInternetFiles” folder in Preferences.</td>
</tr>
<tr>
<td>④ Start up FinePixViewer and click the Update button.</td>
</tr>
</tbody>
</table>

The FinePixViewer Upload dialog box does not appear.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do you have enough memory in your system?</td>
<td>① Quit any other applications that are running.</td>
</tr>
<tr>
<td></td>
<td>② Open “Memory” in “Control Panels” and increase the amount of virtual memory allocated. Then restart your Macintosh.</td>
</tr>
</tbody>
</table>

The “Process aborted because error occurred during communication.” message appears while you are using the FinePixViewer Upload dialog box.

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the following procedure to increase the allocated memory:</td>
</tr>
<tr>
<td>① Close the Upload dialog box and select the “Upload” file in the folder in which FinePixViewer was installed.</td>
</tr>
<tr>
<td>② Select “Get Info” in the “File” menu. The “Upload Info” window opens.</td>
</tr>
<tr>
<td>③ In “Memory”, increase the “Preferred Size” allocation.</td>
</tr>
</tbody>
</table>

Troubleshooting Other Problems

Live images do not appear in the VideoImpression Capture window.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the cradle (camera) switched on?</td>
<td>Switch the camera on. If you are using the cradle, connect the AC power adapter to the cradle and press the “&lt;” button. Refer to the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is “PC Camera” selected as the camera’s USB setting?</td>
<td>Change the camera’s USB setting to “PC Camera”. Refer to “PC Connection” in the Owner’s Manual for your camera for details.</td>
</tr>
<tr>
<td>Is the special USB cable connected to the camera (cradle) and to the computer?</td>
<td>Check that one end of the special USB cable is connected to the camera (cradle) and the other end is connected to the computer.</td>
</tr>
<tr>
<td>Are you using a compatible operating system?</td>
<td>The USB Driver should be used with Mac OS 8.6 to 9.1. (It is not compatible with Mac OS X.)</td>
</tr>
<tr>
<td>Is PC Camera Driver enabled?</td>
<td>Enable “USB04CB_VcShim” and “USB04CB_VcDriver” in the Extensions Manager and restart your Macintosh.</td>
</tr>
<tr>
<td>Is another video input device selected?</td>
<td>Select “USB PC Camera”. Refer to the VideoImpression User’s Guide for information on how to select the video input device.</td>
</tr>
<tr>
<td>Is another application displaying the live images from the camera?</td>
<td>Quit any other application that is displaying live images.</td>
</tr>
<tr>
<td>Did you disconnect the special USB cable or switch off the camera (cradle) during live image display?</td>
<td>Quit VideoImpression and then restart your PC. Check that the special USB cable is connected correctly to the camera and your PC and then switch the camera (cradle) on.</td>
</tr>
</tbody>
</table>

My camera will no longer play back image files.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Did you rename any files or folders inside the DCIM folder?</td>
<td>Change the file or folder names in the DCIM folder back to the original names.</td>
</tr>
<tr>
<td>Did you replace an image file inside the DCIM folder?</td>
<td>Do not replace image files in the DCIM folder.</td>
</tr>
</tbody>
</table>

I want to stop the FinePixViewer from launching automatically.

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can use either of the two methods below to prevent FinePixViewer from launching automatically.</td>
</tr>
<tr>
<td>① Change the Exif Launcher settings.</td>
</tr>
<tr>
<td>① Select “Exif Launcher Settings” in the FinePixViewer “Settings” menu and click “Do not run Exif Launcher at restart.” option.</td>
</tr>
<tr>
<td>② Restart your computer.</td>
</tr>
<tr>
<td>③ To restore the original setting, use the same procedure and tick the “Run Exif Launcher at restart.” option.</td>
</tr>
<tr>
<td>④ Remove Exif Launcher.</td>
</tr>
<tr>
<td>① Select “Exif Launcher Settings” in the FinePixViewer “Settings” menu and tick “Quit Exif Launcher immediately”.</td>
</tr>
<tr>
<td>② Move “Exif Launcher” from the “Startup Items” folder in the System folder to the Trash.</td>
</tr>
<tr>
<td>③ Select “Empty Trash” in the “Special” menu.</td>
</tr>
<tr>
<td>④ To restore Exif Launcher, re-install the software.</td>
</tr>
</tbody>
</table>